The SISO Design Tool

The SISO Design Tool is a graphical user interface (GUI) that facilitates the design of compensators for single-input, single-output feedback loops. The SISO Design Tool allows you to iterate rapidly on your designs and perform the following tasks:

- Manipulate closed-loop dynamics using root locus techniques
- Shape open-loop Bode responses
- Add compensator poles and zeros
- Add and tune lead/lag networks and notch filters
- Inspect closed-loop responses (using the LTI Viewer)
- Adjust phase and gain margins
- Convert models between discrete and continuous time
Opening the SISO Design Tool

This section shows how to open the SISO Design Tool with the DC motor example developed in Chapter 2, Building Models, imported.

If you have not built the DC motor model, type

```matlab
load ltiexamples
```

at the MATLAB prompt. This loads a collection of linear models, including the DC motor. To open the SISO Design Tool and import the DC motor, type

```matlab
siso(sys_dc)
```

at the MATLAB prompt.

This command opens the SISO Design Tool with the root locus and open loop Bode diagrams for the DC motor plotted by default.

![SISO Design Tool with the DC Motor Example](image)

Figure 4-1: SISO Design Tool with the DC Motor Example

The SISO Design Tool displays:

- Poles as x's
- Zeros as o's
- Gain and phase margins (by default) in the lower left-hand corners of the Bode magnitude and phase plots
Getting Started

Importing Models into the SISO Design Tool

If you type

```
sisotool
```

at the MATLAB prompt, an empty SISO Design Tool opens. You can import the DC motor model by selecting Import Model under the File menu. This opens the Import System Data dialog box, which is shown below.

![Import System Data](image)

Figure 4-2: Importing the DC Motor Model into the SISO Design Tool

Follow these steps to import the DC motor model:

1. Select `sys_dc` under SISO Models
2. Place it into the `G` field under Design Model by pressing the right arrow button to the left of `G`
3. Press OK
Getting Started

Feedback Structure

The SISO Design Tool by default assumes that the compensator is in the forward path, i.e., that the feedback structure looks like this picture.

![Feedback Structure Diagram](image)

Figure 4-3: The Default Feedback Structure -- Compensator in the Forward Path

In this picture, the lettered boxes represent the following:

- G -- plant
- H -- sensor dynamics
- F -- prefilter
- C -- compensator

The default values for F, H, and C are all 1. Note that this means that by default, the compensator has unity gain. G contains the DC motor model, sys_dc.

Alternative Feedback Structure

Clicking the FS button toggles between the default feedback structure and a feedback structure that places the compensator in the feedback path. This picture shows the alternate feedback structure.

![Alternative Feedback Structure Diagram](image)

Figure 4-4: Alternate Feedback Structure with the Compensator in the Feedback Loop

Importing Models into the SISO Design Tool  
Loop Responses
Getting Started

Loop Responses

As you iterate on a compensator design, you may find it convenient to be able to examine the various loop responses (for example, step or impulse responses). To view, for example, the closed-loop step response, select Plant Output (Step) under Loop Responses from the Tools menu. This opens an LTI Viewer with the closed-loop step response of the DC motor. For instructions on how to operate the LTI Viewer, see LTI Viewer.

This figure shows the resulting plot.

Figure 4-5: LTI Viewer Showing the Step Response for the DC Motor

As this plot shows, the step response of the DC motor is about 1.5 seconds, which is too slow for many applications. Also, there is a large steady-state error. The following sections show how to use Bode diagram techniques for improving the response time and steady-state error of the DC motor step response.

As you iterate on a design, the LTI Viewer associated with your SISO Design Tool will automatically update the response plots you have chosen.
Bode Diagram Design

One technique for compensator design is to work with Bode diagrams of the open-loop response (loop shaping). Using Bode diagrams, you can design to gain and phase margin specifications, adjust the bandwidth, and add notch filters for disturbance rejection.

Example: DC Motor

The following sections use the DC motor example to show how create a compensator using Bode diagram design techniques. From "SISO Example: the DC Motor" on page 2-4, the transfer function of the DC motor is

\[
\text{Transfer function:} \\
\frac{1.5}{s^2 + 14s + 40.02}
\]

For this example, the design criteria are as follows:

- Rise time of less than 0.5 second
- Steady-state error of less than 5%
- Overshoot of less than 10%
- Gain margin greater than 20 dB
- Phase margin greater than 40 degrees
Adjusting the Compensator Gain

Figure 4-5 shows that the closed-loop step response is too slow. The simplest approach to speeding up the response is to increase the gain of the compensator. To increase the gain:

1. Move the mouse pointer over the Bode magnitude line. Notice how the pointer becomes a hand.
2. Grab the Bode magnitude line by holding down the left mouse button when the hand appears.
3. Drag the Bode plot line upward.
4. Release the mouse button. The gain and poles changes as the closed-loop set point is recomputed.

The SISO Design Tool calculates the compensator gain, and the value appears in the C(s) text box on the GUI.

Alternatively, you can set the gain by entering the desired value in the C(s) field in the Current Compensator panel.

Right-Click Menus

The SISO Design Tool has right-click menus available in any of the plot regions. The menus are customized for each plot type, open the Bode magnitude menu by right-clicking your mouse in the white space of the Bode magnitude plot. This menu appears.

![Right-Click Menu for the Bode Magnitude Plot](image)

The right-click menus contain numerous features. The DC motor example makes use of many of the available features; for a complete discussion of the right-click menus, see the online help for the SISO Design Tool in "Tool and Viewer Reference."

Bode Diagram Design

Adjusting the Bandwidth
Getting Started

Adjusting the Bandwidth

Since the design requirements include a 0.5 second rise time, try setting the gain so that the DC crossover frequency is about 3 rad/sec. The rationale for setting the bandwidth to 3 rad/sec is that, to a first-order approximation, this should correspond to about a 0.33 second time constant.

To make the crossover easier to see, select Grid from the right-click menu. This creates a grid for the Bode magnitude plot. Left-click on the Bode magnitude plot and drag the curve until you see the curve crossing over the 0 dB line (on the y axis) at 3 rad/sec. This changes both the SISO Design Tool display and the LTI Viewer step response.

This figure shows the SISO Design Tool.

Figure 4-7: Root Locus and Bode Plots for the DC Motor

For a crossover at 3 dB, the compensator gain should be about 38. By default, the SISO Design Tool displays gain and phase margin information in the lower left-hand corners of the Bode diagrams. In the Bode magnitude plot, it also tells you if your closed-loop system is stable or unstable.

This plot shows the associated closed-loop step response in the LTI Viewer.
Figure 4-8: Closed-Loop Step Response for the DC Motor with a Compensator Gain = 38

The step response shows that the steady-state error and rise time have improved somewhat, but you must design a more sophisticated controller to meet all the design specifications, in particular, the steady-state error requirement.
Getting Started

Adding an Integrator

One way to eliminate steady-state error is to add an integrator. To do this, select Add and then Integrator from the right-click menu. This figure shows the process.

![Image: SISO Design for System sys_dc](image)

Figure 4-9: Using the Right-Click Menu to Add an Integrator

Notice adding the integrator changed the crossover frequency of the system. Readjust the compensator gain to bring the crossover back to 3 dB; the gain should be about 100.

Once you have added the integrator and readjusted the compensator gain, the SISO Design Tool shows a red `x` at the origin of the root locus plot.
Adding an integrator changed the gain margin from infinity to 11.5 dB. The SISO Design Tool displays the gain margin as a brown stem.

Figure 4-10: The SISO Design Tool Displays the Integrator on the Root Locus Plot

This figure shows the closed-loop step response.
Figure 4-11: The Step Response for the DC Motor with an Integrator in the Compensator

The step response is settling around 1, which satisfies the steady-state error requirement. This is because the integrator forces the system to zero steady-state error. The figure shows, however, that the peak response is 1.3, or about 30% overshoot, and that the rise time is roughly 0.4 second. So a compensator consisting of an integrator and a gain is not enough to satisfy the design requirements, which require that the overshoot be less than 10%.

Adjusting the Bandwidth
Adding a Lead Network
Getting Started

**Adding a Lead Network**

Part of the design requirements is a gain margin of 20 dB or greater and a phase margin of 40° or more. In the current compensator design, the gain margin is 11.5 dB and the phase margin is 38.1°, both of which fail to meet the design requirements. So two goals left are to shorten the rise time while improving the stability margins. One approach is to increase the gain to speed up the response, but the system is already underdamped, and increasing the gain will decrease the stability margin as well. You might try experimenting with the compensator gain to verify this. The only option left is to add dynamics to the compensator.

One possible solution is to add a lead network to the compensator. To make this easier to do on the diagram, zoom in on the x-axis. First, select Zoom In-X from the right-click menu; then select a region of the Bode magnitude plot by left-clicking and dragging your mouse. The range from 1 to about 50 rad/sec is good. This picture shows the process.

![SISO Design Tool](image)

The SISO Design Tool will zoom in on this region of the x-axis when you release your mouse.

**Figure 4-12: Zooming in on the X-Axis of the Bode Plots**

To add the lead network, choose Add and then Lead in the right-click menu for the Open-Loop Bode diagram. This figure shows the process of adding a lead network to your controller.
Figure 4-13: Adding a Lead Network to the DC Motor Compensator Using Right-Click Menus

Selecting a lead network causes your cursor to change to an ‘x.’ Position this ‘x’ on the Bode magnitude curve slightly to the right of the rightmost pole and click. Your SISO Design Tool and LTI Viewer plots should now look similar to these.

Figure 4-14: Root Locus, Bode, and Step Response Plots for the DC Motor with a Lead Network

The Step Response plot shows that the rise time is now about 0.4 second and peak response is 1.25 rad/sec (i.e., the
overshoot is about 25%). Although the rise time meets the requirement, the overshoot is still too large, and the stability margins are still unacceptable, so you must tune the lead parameters.

Adding an Integrator

Moving Compensator Poles and Zeros
Getting Started

Moving Compensator Poles and Zeros

To improve the response speed, move the lead network zero closer to the leftmost (slowest) pole of the DC motor plant (denoted by a blue `x`). To do this, just grab the zero and drag it with your mouse. Try positioning the zero near the slowest plant pole.

Now try moving the lead network pole to the right. Notice how the gain margin increases as you do this. You can also use the gain to increase the gain margin; grab the Bode magnitude curve and drag it upward with your mouse to see the gain and gain margin increase.

As you tune these parameters, take a look at the LTI Viewer. You will see the closed-loop step response alter with each parameter change you make. The figure below shows the final values for a design that meets the specifications.

![SISO Design for System sys dc](image)

Figure 4-15: Final Design Parameters for the DC Motor Compensator

The values for this final design are as follows:

- Poles at 0 and -28
- Zero at -4.3
- Gain = 84

You can use the Edit Compensator dialog box to specify the exact values. Double-click in the Current Compensator panel to open the window. This figure shows that the gain margin is 22 dB, and the phase margin is 66°. To see if the design meets the rise time and overshoot requirements, go to the closed-loop step response, right-click in an empty region of the plot, and select Characteristics and then Rise Time and Peak Overshoot. This figure shows the plot with the rise time and overshoot denoted by large dots on the curve.
Figure 4-16: Step Response for the Final Compensator Design

The step response shows that the rise time is 0.45 second, and the peak amplitude is 1.03 rad/sec, or an overshoot of 3%. These results meet the design specifications.
Getting Started

Changing Units on a Plot

The Control System Toolbox provides editors for setting plot options. If you want, for example, to change the frequency units on all the Bode plots created in the SISO Design Tool from \( \text{rad/sec} \) to \( \text{Hertz} \), select SISO Tool Preferences under Edit in the menu bar. This opens the SISO Tool Preferences editor.

![SISO Tool Preferences Editor]

Figure 4-17: The SISO Tool Preferences Editor

Use the menu options on the Units page to make the change. This unit change persists for the entire session.

For more information about property and preference setting, see Customization online under the Control System Toolbox.
Getting Started

Adding a Notch Filter

If you know that you have disturbances to your system at a particular frequency, you can use a notch filter to attenuate the gain of the system at that frequency. To add a notch filter, select Add Notch from the right-click menu and place the filter at the frequency you want to attenuate. A black ‘x’ will appear next to the mouse arrow; place it at the frequency you want to attenuate.

This figure shows the result:

Figure 4-18: The SISO Tool with a Notch Filter Added to the DC Motor Compensator

Note that to add the notch filter it was necessary to zoom out, since the notch frequency is at a higher frequency than Figure 4-15 displayed.

To see the notch filter parameters in more detail, select Zoom X-Y in the right-click menu for the Bode magnitude plot. Left-click and drag your mouse to draw a box around the notch filter. When you release the mouse, the SISO Design Tool will zoom in on the selected region.

This figure zooms in on the notch filter to show the adjustable parameters.
Figure 4-19: Manipulating Notch Filter Parameters

To understand how adjusting the notch filter parameters affects the filter, consider the notch filter transfer function.

\[
\frac{s^2 + 2\xi_1 \omega_n s + \omega_n^2}{s^2 + 2\xi_2 \omega_n s + \omega_n^2}
\]

The three adjustable parameters are \(\xi_1\), \(\xi_2\), and \(\omega_n\). The ratio of \(\xi_2 / \xi_1\) sets the depth of the notch, and \(\omega_n\) is the natural frequency of the notch. This diagram shows how moving the red \(\bigcirc\) and black diamonds change these parameters, and hence the transfer function of the notch filter.

Figure 4-20: A Close Look at Notch Filter Parameters
Getting Started

Root Locus Design

A common technique for meeting design criteria is root locus design. This approach involves iterating on a design by manipulating the compensator gain, poles, and zeros in the root locus diagram.

The root locus diagram shows the trajectories of the closed-loop poles of a feedback system as a single system parameter varies over a continuous range of values. Typically, the root locus method is used to tune the loop gain of a SISO control system by specifying a feedback gain the closed-loop pole locations.

Consider, for example, the tracking loop

\[ r \xrightarrow{\ } \bigcirc \xrightarrow{\ } P(s) \xrightarrow{\ } y \]

\[ k \xleftarrow{\ } H(s) \xleftarrow{\ } \]

where \( P(s) \) is the plant, \( H(s) \) is the sensor dynamics, and \( k \) is a scalar gain to be adjusted. The closed-loop poles are the roots of

\[ q(s) = 1 + k \cdot P(s)H(s) \]

The root locus technique consists of plotting the closed-loop pole trajectories in the complex plane as \( k \) varies. You can use this plot to identify the gain value associated with a desired set of closed-loop poles.

The DC motor design example focused on the Bode diagram feature of the SISO Design Tool. Each of the design options available on the Bode diagram side of the tool have a counterpart on the root locus side. To demonstrate these techniques, this example presents an electrohydraulic servomechanism.

The SISO Design Tool's root locus and Bode diagram design tools provide complementary perspectives on the same design issues; each perspective offers insight into the design process. Since the SISO Design Tool displays both root locus and Bode diagrams, you can also choose to combine elements of both perspectives in making your design decisions.
**Example: Electrohydraulic Servomechanism**

A simple version of an electrohydraulic servomechanism model consists of:

- A push-pull amplifier (a pair of electromagnets)
- A sliding spool in a vessel of high pressure hydraulic fluid
- Valve openings in the vessel to allow for fluid to flow
- A central chamber with a piston-driven ram to deliver force to a load
- A symmetrical fluid return vessel

This figure shows a schematic of this servomechanism.

![Schematic of Electrohydraulic Servomechanism](image)

**Figure 4-21: An Electrohydraulic Servomechanism**

The force on the spool is proportional to the current in the electromagnet coil. As the spool moves, the valve opens, allowing the high pressure hydraulic fluid to flow through the chamber. The moving fluid forces the piston to move in the opposite direction of the spool. *Control System Dynamics*, by R. N. Clark, (Cambridge University Press, 1996) derives linearized models for the electromagnetic amplifier, the valve spool dynamics, and the ram dynamics; it also provides a detailed description of this type of servomechanism.

If you want to use this servomechanism for position control, you can use the input voltage to the electromagnet to control the ram position. When measurements of the ram position are available, you can use feedback for the ram position control, as shown in the figure below.

![Feedback Control Structure](image)

**Figure 4-22: Feedback Control Structure for an Electrohydraulic Servomechanism**

Your task is to design the compensator, C(s).

**Plant Transfer Function**

If you have not already done so, type
to load a collection of linear models that include \texttt{Gservo}, which is a linearized plant transfer function for the electrohydraulic position control mechanism. Typing \texttt{Gservo} at the MATLAB prompt displays the servomechanism (plant) transfer function.

\begin{verbatim}
Gservo

Zero/pole/gain from input "Voltage" to output "Ram position":

\begin{verbatim}
40000000
\end{verbatim}

\begin{verbatim}
\text{Zero:}\ \ s \ (s+250) \ \text{(s^2 + 40s + 9e004)}
\end{verbatim}
\end{verbatim}

**Design Specifications**

For this example, you want to design a controller so that the step response of the closed-loop system meets the following specifications:

- The 2% settling time is less than 0.05 second.
- The maximum overshoot is less than 5%.

The remainder of this section discusses how to use the SISO Design Tool to design a controller to meet these specifications.

**Opening the SISO Tool**

Open the SISO Design Tool and import the model by typing

\begin{verbatim}
\texttt{sisotool(Gservo)}
\end{verbatim}

at the MATLAB prompt. This opens the SISO Design Tool with the servomechanism plant imported.

**Figure 4-23: SISO Design Tool Showing the Root Locus and Bode Plots for the Electrohydraulic Servomechanism Plant**

**Zooming**

Using the right-click menu in the root locus, select X-Y under Zoom. Hold down the mouse's left button and drag the mouse to select a region for zooming. For this example, reduce the root locus region to about -500 to 500 in both the x- and y-axes. This figure illustrates the zooming in process.
Hold down your mouse’s left button to select a rectangular region for zooming in. When you let go of the button, the SISO Design Tool replots the root locus with the new axis boundaries. To undo the zoom, select ‘Zoom Out’ in the right-click menu.

Figure 4-24: Zooming in on a Region in the Root Locus Plot

Alternatively, you use the zoom icons on the toolbar:

- ![Zoom in X-Y icon]
- ![Zoom in X icon]
- ![Zoom in Y icon]
- ![Zoom out icon]

As in the DC motor example, open an LTI Viewer by selecting Plant Output (Step) in the Loop Responses menu under Tools in the menu bar. You now should have two windows, the SISO Design Tool and the associated LTI Viewer side by side.

Figure 4-25: SISO Design Tool and Associated LTI Viewer for the Electrohydraulic Servomechanism

The step response plot shows that the rise time is on the order of 2 seconds, which is much too slow given the system requirements. The following sections describe how to use frequency design techniques in the SISO Design Tool to design a compensator that meets the requirements specified in Design Specifications.
Changing the Compensator Gain

The simplest thing to do is change the compensator gain, which by default is unity. You can change the gain by grabbing the red squares on the root locus plot and moving them along the curve. This figure shows the procedure.

![SISO Design for System Gs servo](image)

Move the red squares to change the compensator gain. The SISO Design Tool calculates the compensator gain \( C(s) \) and displays it in the Current Compensator panel.

Figure 4-26: Changing the Compensator Gain in the Root Locus Plot

Experiment with different gains and view the closed-loop response in the associated LTI Viewer.

Alternatively, you can change the compensator gain by entering values into the \( C(s) \) field in the Current Compensator panel.

Closed-Loop Response

Change the gain to 20 by editing the text box next to Gain, and pressing the Enter key. Notice that the locations of the closed-loop poles on the root locus are recalculated for the new gain set point.

This figure shows the associated closed-loop step response for the gain of 20.
Figure 4-27: Step Response with the Settling Time for $C(s) = 20$

This closed-loop response does not meet the desired settling time requirement (0.05 seconds or less) and exhibits unwanted ringing. The next section shows how to design a compensator so that you meet the required specifications.

Example: Electrohydraulic Servomechanism  

Adding Poles and Zeros to the Compensator
Getting Started

**Adding Poles and Zeros to the Compensator**

You may have noticed that increasing the gain makes the system underdamped. Further increases force the system into instability, so meeting the design requirements with only a gain in the compensator is not possible.

There are three sets of parameters that specify the compensator: poles, zeros, and gain. Once you have selected the gain, you can add poles or zeros to the compensator.

**Adding Poles to the Compensator**

Try adding a complex conjugate compensator pole pair on the root locus plot:

1. Open the right-click menu and select Add and then Complex Pole.
2. Click on the root locus plot region where you would like to add one of the complex poles.

This figure shows these two steps.

Add the poles by placing the ‘x’ on the Bode magnitude plot. The SISO Design Tool places the poles at the location that you mark.

Figure 4-28: Adding a Complex Pair of Poles to the Compensator

Try placing the ‘x’ somewhere to the left of the complex pole pair near the imaginary axis (the figure above shows a good spot). Once you have added the complex pair of poles, the LTI Viewer response plots change and both the root locus and Bode plots display the new poles. This figure shows the SISO Design Tool with the new poles added. For clarity, you may want to zoom out further, as was done here.
The Current Compensator displays the new complex pair of poles. If you see NumC or DenC, widen the GUI to see the full transfer function.

The SISO Design Tool displays the new poles as a pair of red x's on the root locus plot.

Figure 4-29: The Result of Adding a Complex Pair of Poles to the Compensator

Adding Zeros to the Compensator

The procedure for adding zeros to the compensator is exactly the same. Try adding a pair of complex zeros just to the left of complex closed-loop poles you just added to the compensator. This figure shows the results.

Figure 4-30: Electrohydraulic Servomechanism Example with Complex Zeros Added

If your step response is unstable, lower the gain by grabbing a red box in the right-hand plane and moving it into the left-half plane. In this example, the resulting step response is stable, but it still doesn't meet the design criteria since the 2% settling time is greater than 0.05 second.

As you can see, the compensator design process can involve some trial and error. You can try dragging the compensator poles, compensator zeros, or the closed-loop poles around the root locus until you meet the design criteria.

The next section shows you how to place poles and zeros by specifying their numerical values. It also presents a solution that meets the design specifications for the servomechanism example.

Viewing Damping Ratios

If you want to place, for example, a pair of complex poles on your diagram at a particular damping ratio, select Design Constraints from the right-click menu in the root locus. This opens the Design Constraints editor.
Figure 4-31: The Design Constraints Editor

Applying damping ratios to the root locus plot results in a pair of lines at the desired slope, as this figure shows.

Figure 4-32: Root Locus Displaying 0.707 Damping Ratio Lines

Try moving the complex pair of poles you’ve added to the design so that they are on the 0.707 damping ratio line. You can experiment with different damping ratios to see the effect on the design.
Getting Started

Editing Compensator Pole and Zero Locations

A quick way to change poles and zeros is simply to grab them with your mouse and move them around the root locus plot region. If you want to specify precise numerical values, however, you should use the Edit Compensator window to change the gain value and the pole and zero locations of your compensator.

There are three ways to open the Edit Compensator window from the SISO Design Tool:

- Select Edit Compensator under the Edit menu on the menu bar.
- Select Edit Compensator in the right-click menu. This option is available in both the root locus and Bode plot right-click menus.
- Double-click your mouse in the Current Compensator panel.

Whichever method you choose, the following window appears.

![Edit Compensator Window]

Figure 4-33: Use the Edit Compensator Window to Add, Delete and Move Compensator Poles and Zeros

You can use the Edit Compensator window to:

- Edit the compensator gain
- Edit the locations of compensator poles and zeros
- Add compensator poles and zeros
- Delete compensator poles and zeros

For this example, edit the poles to be at $-110 \pm 140i$ and the zeros at $-70 \pm 270i$. Set the compensator gain to 23.3.

Your SISO Design Tool now looks like this.
Figure 4-34: SISO Design Tool with the Final Values for the Electrohydraulic Servomechanism Design Example

To see that this design meets the design requirements, take a look at the step response of the closed-loop system.
Figure 4-35: Closed-Loop Step Response for the Final Design of the Electrohydraulic Servomechanism Example

The step response looks good. As you can see, the settling time is less than 0.05 second, and the overshoot is less than 5%. You have met the design specifications.
Getting Started

Exporting the Compensator and Models

Now that you have successfully designed your compensator, you may want to save your design parameters for future implementation. You can do this by selecting Export from the File menu on the SISO Design Tool. The window shown below opens.

![SISO Tool Export Window](image)

Double-click on any cell in the Export As column to edit the name for export.

Figure 4-36: SISO Tool Export Window

The variables listed in the Export As List are either previously named by you (in the Import System Data window) or have default names. To export your compensator to the workspace:

1. Select Compensator C in the Component List. If you want to change the export name, double-click in the cell for compensator C.
2. Click on the Export to Workspace button.

If you go to the MATLAB prompt and type

```
who
```

the compensator is now in the workspace, in the variable named c.

Type

```
c
```

to see that this variable is stored in zpk format.

To select multiple components, use the Shift key if they are all adjacent and the Ctrl key if they are not.

Selecting Export to Disk opens the window shown below.
You can save your models as MAT-files in any directory you want. The default name for the MAT-file is the name of your original model; you can change the name to anything you want. If you save multiple components, they are stored in a single MAT-file.

[Link: Editing Compensator Pole and Zero Locations] [Link: Storing and Retrieving Intermediate Designs]
Getting Started

Storing and Retrieving Intermediate Designs

You can store and retrieve intermediate compensators while you iterate on your compensator design. To store intermediate designs, select Store under Compensator in the menu bar of the SISO Design Tool. This window opens.

The default name is UntitledC_1; the suffix increments when you store additional compensators. You can rename the designs by editing the Store as field.

To retrieve intermediate designs, select Retrieve under the Compensator menu. This opens the Compensator Designs window.

Figure 4-37: The Compensator Designs Window

To retrieve a design, select it from the list of names and press Retrieve. The SISO Design Tool automatically reverts to the selected compensator design. Note that you can rename the stored compensator by editing the name in the selected Name cell.

The Compensator Designs window also lists the order of each compensator design, and, if the compensator is digital, the sample time. The default sample time value for continuous-time compensators is 0.

You can delete an intermediate design by selecting it and pressing the Delete button.

Exporting the Compensator and Models

Functions For Compensator Design